
Chapter 14

Working with Blocks

After completing this chapter, you will be able to:
• Create blocks using the Block Definition dialog box.
• Insert blocks using the Insert dialog box.
• Create drawing files using the Write Block dialog box.
• Use the DESIGNCENTER to locate, preview, copy, or insert blocks and existing drawings.
• Use the TOOL PALETTES window to insert blocks.
• Split a block into individual objects using the EXPLODE and XPLODE commands.
• Rename blocks and delete unused blocks.

Learning Objectives
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THE CONCEPT OF BLOCKS
The ability to store parts of a drawing, or the entire drawing, so that they need not be redrawn
when required in the same drawing or another drawing is a great benefit to the user. These parts
of a drawing, entire drawings, or symbols (also known as blocks) can be placed (inserted) in a
drawing at the location of your choice, in the desired orientation, and with the desired scale
factor. The block is given a name (block name) and is referenced (inserted) by its name. All the
objects within a block are treated as a single object. You can MOVE, ERASE, or LIST the block
as a single object, that is, you can select the entire block simply by selecting anywhere on it. As
for the edit and inquiry commands, the internal structure of a block is immaterial, since a block
is treated as a primitive object, like a polygon. If a block definition is changed, all references to
the block in the drawing are updated to incorporate the changes made to it.

A block can be created using the BLOCK command. You can also save objects in a drawing, or
an entire drawing as a drawing file using the WBLOCK command. The main difference between
the two is that a wblock can be inserted in any other drawing, but a block can be inserted only in
the drawing file in which it was created.

Another feature of AutoCAD LT is that instead of inserting a symbol as a block (which results in
adding the content of the referenced drawing to the drawing in which it is inserted), you can
reference the other drawings (Xref) in the current file. This means that the contents of the
referenced drawing are not added to the current drawing file, although they become part of that
drawing on the screen. This is explained in detail in Chapter 16.

Advantages of Using Blocks
Blocks offer many advantages. Here are some of them.

1. Drawings often have some repetitive features. Instead of drawing the same feature again and
again, you can create a block of this feature and insert it wherever required. This  helps you
to reduce drawing time and better organize your work.

2. Another advantage of using blocks is that they can be drawn and stored for future use. You
can thus create a custom library of objects required for different applications. For example,
if your drawings are concerned with gears, you could create blocks of gears and then integrate
them with custom menus (see Chapter 32, for writing menus). In this manner, you could
create an application environment of your own in AutoCAD LT.

3. The size of a drawing file increases as you add objects to it. AutoCAD LT keeps track of
information about the size and position of each object in the drawing; for example, the
points, scale factors, radii, and so on. If you combine several objects into a single object by
forming a block with the BLOCK command, there will be a single scale factor,
rotation angle, position, and so on, for all objects in the block, thereby saving storage space.
Each object repeated in multiple block insertions needs to be defined only once in the
block definition. Ten insertions of a gear, made of forty-three lines and forty-one arcs,
require only ninety-four objects (10+43+41), while ten individually drawn gears require
840 objects [10 X (43+41)].

4. If the specification for an object changes, the drawing needs to be modified. This is a very
tedious task if you need to detect each location where the change is to be made and edit it
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individually. But if this object has been defined as a block, you can redefine it, and everywhere
the object appears, it is revised automatically. This has been dealt with in Chapter 15,
Defining Block Attributes.

5. Attributes (textual information) can be included in blocks. Different attribute values can be
specified in each insertion of a block.

6. You can create symbols and then store them as blocks with the BLOCK command. Later on,
with the INSERT command, you can insert the blocks in the drawing, in which they were
defined. There is no limit to the number of times you can insert a block in a drawing.

7. You can store symbols as drawing files using the WBLOCK command and later insert these
symbols into any other drawing using the INSERT command.

8. Blocks can have varying X, Y, and Z scale factors and rotation angles from one insertion to
another (Figure 14-1).

9. You can insert multiple copies of a block about a specified path using the DIVIDE or the
MEASURE command.

FORMATION OF BLOCKS
Drawing Objects for Blocks
The first step in creating blocks is to draw the object(s) to be converted into a block. You can
consider any symbol, shape, or view that may be used more than once for conversion into a
block (Figure 14-2). Even a drawing that is to be used more than once can be inserted as a block.

Tip
Examine the sketch of the drawing you are about to begin and examine it carefully to look for
any shapes, symbols, and components that are to be used more than once. They can then be
drawn once and be stored as blocks.

Figure 14-1  Block with different specifications
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Checking Layers
You should be particularly careful about the layers on which the objects to be converted into a
block are drawn. The objects must be drawn on layer 0 if you want the block to inherit the
linetype and color of the layer on which it is inserted. If you want the block to retain the linetype
and color of the layer on which it was drawn, draw the objects defining the block on that layer.
For example, if you want the block to have the linetype and color of layer OBJ, draw the objects
comprising the block on layer OBJ. Now, even if you insert the block on any other layer, the
linetype and color of the block will be those of layer OBJ.

If the objects in a block are drawn with the color, linetype, and lineweight as ByBlock, this block
when inserted assumes the properties of the current layer. To set the color to ByBlock, select
ByBlock from the Color Control drop-down list of the Properties toolbar. You can also choose
Color from the Format menu to display the Select Color dialog box and then choose the
ByBlock button in the dialog box. Choose OK to close the dialog box. To set the linetype to
ByBlock, select ByBlock from the Linetype Control drop-down list of the Properties toolbar.
You can also select ByBlock in the Linetype Manager dialog box that is displayed when you
choose Linetype from the Format menu and then choose the Current button. The current
linetype is now set to ByBlock. Similarly, you can specify the lineweight as ByBlock.

Note
As discussed previously, before you create a block you should check the layers on which the objects
are drawn because these layers will determine the color and linetype of the block when inserted.
To change the layer associated with an object, use the Properties toolbar, PROPERTIES palette,
Properties option of the CHANGE command, or the CHPROP command.

CONVERTING OBJECTS INTO A BLOCK
You can convert objects into a block either using the Block Definition dialog box or by using the
command line. Both these options are discussed next.

Figure 14-2  Some common drafting symbols created to be stored in a library
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Converting Objects Into Blocks Using the Block Definition
Dialog Box

When you invoke the BLOCK command (Figure 14-3), the
Block Definition dialog box (Figure 14-4) is displayed. You
can use the Block Definition dialog box to save any object
or objects as a block.

Toolbar: Draw > Make Block
Menu: Draw > Block > Make
Command: BLOCK

Figure 14-3  The Make Block button
in the Draw toolbar

Figure 14-4  The Block Definition dialog box
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In the Block Definition dialog box, you can enter the name of the block you want to create in the
Name edit box. All the block names present in a current drawing are displayed in the Name
drop-down list in an alphabetical and numerical order. If a drawing contains more than six
blocks, a scroll bar appears on the right side of the Name drop-down list, which can be moved
up and down to view all the blocks in the drawing. This way you can verify whether a block you
have defined has been saved. By default, the block name can have up to 255 characters. The
name can contain letters, digits, blank spaces as well as any special characters including the $
(dollar sign), - (hyphen), and _ (underscore), provided they are not being used for any other
purpose by AutoCAD LT or Windows.

Note
The block name is controlled by the EXTNAMES system variable and the default value is 1. If
the value is set to 0, the block name will be only thirty-one characters long and will not include
spaces or any other special characters apart from a $ (dollar sign), - (hyphen), or _ (underscore).

If a block already exists with the block name that you have specified in the Name edit box, an
AutoCAD LT dialog box, warning that the block name is already defined, is displayed when you
choose the OK button in the Block Definition dialog box. In this dialog box, you can either
redefine the existing block by choosing the Yes button or you can exit it by choosing the No
button. You can then use another name for the block in the dialog box for it.

After you have specified a block name, you are required to specify the insertion base point. This
point is used as a reference point to insert the block. Usually, either the center or the lower left
corner of the block is defined as the insertion base point. Later on, when you insert the block,
you will notice that it appears at the insertion point, and you can insert the block with reference
to this point. The point you specify as the insertion base point is taken as the origin point of the
block’s coordinate system. You can specify the insertion point by choosing the Pick point button
in the Base point area of the dialog box. The dialog box is temporarily removed, and you can
select a base point on the screen. You can also enter the coordinates in the X:, Y:, and Z: edit
boxes instead of selecting a point on screen. Once the insertion base point is specified, the
dialog box reappears and the X, Y, and Z coordinates of the insertion base point are displayed
in the X, Y, and Z edit boxes, respectively. If no insertion base point is selected, AutoCAD LT
assumes the insertion point coordinates to be 0,0,0, which are the default coordinates.

Tip
In drawings where the insertion point of a block is important, for example, in the case of
inserting the block of a door symbol in architectural plans, it may be a good idea to first specify
the requisite scale factors and rotation angles and then the insertion point. This way, you are
able to preview the block symbol as it is to be inserted.

After specifying the insertion base point, you are required to select the objects that will constitute
the block. Until the objects are selected, AutoCAD LT displays a warning: No objects selected,
at the bottom of the Objects area. Choose the Select objects button. The dialog box is temporarily
removed from the screen. You can select the objects on the screen using any selection method.
After completing the selection process, right-click or press the ENTER key to return to the
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dialog box. The number of objects selected is displayed at the bottom of the Objects area of the
dialog box.

The Objects area of the Block Definition dialog box also has a QuickSelect button. If you
choose this button, the Quick Select dialog box is displayed, which allows you to define a
selection set based on the properties of objects. Quick Select is used in cases where the drawings
are very large and complex. The Quick Select dialog box has been discussed earlier in Chapter 6,
Editing Sketched Objects-II.

In the Objects area, if you select the Retain radio button, it retains the selected objects that form
the block as individual objects and does not convert them into a block after the block has been
defined. If you select the Convert to block radio button, it converts the selected objects into a
block after you have defined the block. If you select the Delete radio button, it deletes the
selected objects from the drawing after the block has been defined.

Tip
When you select the Delete radio button in the Objects area when defining a block, the
selected objects are removed from the drawing. If you want them back, you can use the OOPS
command. Using U at the Command prompt, or choosing the Undo button from the Standard
toolbar will undo the block definition from the drawing.

In the Settings Area, if you select the Scale Uniformly check box, the block can only be scaled
uniformly in all directions, while inserting. If you select the Allow Exploding check box, the
block can be exploded into separate entities using the EXPLODE command, whenever required.

The Blocks unit drop-down list displays the units that will be used when inserting the current
block. For example, if the block is created with inches as the units and you select Feet from the
Block unit drop-down list, the block will be scaled to feet.

After setting all the parameters in the Block Definition dialog box, choose the OK button to
complete defining the block.

Tip
It is a good idea to create a unit block, especially for drawings where the same block is to be
inserted with various scale factors. A unit block can be defined as a block that is created within
a unit square area (1 unit x 1 unit). This way, every time you specify a scale factor, the block
simply gets enlarged or reduced by the said amount directly, since the multiplication factor is 1.

Note
You can also create blocks using the command line by entering -BLOCK at the Command prompt.

Converting Objects Into a Block Using the Command Line
You can use the -BLOCK command to create blocks from the command line. The following
prompt sequence saves a symbol as a block named SYMBOLX.
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Command: -BLOCK
Enter block name or [?]: SYMBOLX
Specify insertion base point: Select a point.
Select objects: Select all the objects comprising the block.
Select objects: Press ENTER when selection is complete.

AutoCAD LT acknowledges the creation of the block by removing the objects defining the block
from the screen. You can get the objects back at the same position by entering OOPS. You can
use the ? option to list all the blocks created in the drawing. The prompt sequence is given next.

Command: -BLOCK
Enter block name or [?]: ?
Enter block(s) to list <*>: �

Information similar to the following is displayed in the AutoCAD LTText Window.
Defined blocks
“BLK1”
“BLK2”
“SYMBOLX”
User External Dependent Unnamed
Blocks References Blocks Blocks
n n n n

Here n denotes a numeric value.

Defined blocks. The names of all the blocks defined in the drawing.

User Blocks. The number of blocks created by the user.

External References. The number of external references. These are the drawings that are
referenced with the XREF command and are discussed later in Chapter 16.

Dependent Blocks. The number of externally dependent blocks. These are the blocks that are
present in a referenced drawing.

Unnamed blocks. The number of unnamed blocks in the drawing. These are objects such as
associative dimensions and hatch patterns.

Draw a unit radius circle, and use the BLOCK command to create a block. Name the block
CIRCLE. Figure 14-5 shows the steps involved in creating a block. Select the center as the
insertion point. Verify if the block CIRCLE was saved.

Exercise 1 General
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INSERTING THE BLOCKS USING THE INSERT DIALOG BOX

Insertion of a predefined block is possible with the INSERT
command (Figure 14-6). An inserted block is called a block
reference. You should determine the layer on which you
want to insert the block, the location where you want to insert it, its size, and the angle by which
you want the block to be rotated, prior to insertion. If the layer on which you want to insert the
block is not current, you can use the Layer Control drop-down list in the Layers toolbar or
choose the Current button in the Layer Properties Manager dialog box to make it current.
When you invoke the INSERT command, the Insert dialog box (Figure 14-7) is displayed. You
can specify the different parameters of the block or external file to be inserted in the Insert dialog
box.

Name
This drop-down is used to specify the name of the block to be inserted. Select the name of the
block to be inserted from this drop-down list. You can also enter the name of the block to be
inserted. All the blocks created in the current drawing are available in the Name drop-down list.

Note
The last block name selected from the Name drop-down list and inserted becomes the default
name for the next insertion and is displayed in this drop-down list.

Toolbar: Insert > Insert Block
Draw > Insert Block

Menu: Insert > Block
Command: INSERT

Figure 14-5  Using the BLOCK command

Figure 14-6  Invoking the INSERT
command from the Insert toolbar



14-10                                                                                            AutoCAD LT 2006 for Designers

The Browse button is used to insert external files. When you choose this button, the Select
Drawing File dialog box is displayed. This dialog box works in a manner similar to the standard
Select File dialog box, which has been discussed earlier in Chapter 1. You can select a drawing
file from the listed drawing files existing in a current directory, and can change the directory by
selecting the desired directory in the Look in drop-down list. Once you select the drawing file
in this dialog box and choose the Open button, the drawing file name is displayed in the Name
drop-down list of the Insert dialog box. Path displays the path of the external file selected to be
inserted. Now, if you want to change the block name, just change it in the Name drop-down list.
In this manner, the drawing can be inserted with a different name. Changing the original
drawing does not affect the inserted drawing.

Note
If the name you have specified in the Name edit box does not exist as a block in the current
drawing, AutoCAD LT will search the drives and directories on the path (specified in the Options
dialog box) for a drawing of the same name and if it finds it, it will insert it.

Also, suppose you have inserted a block in a drawing and then you want to insert a drawing with
the same name as the block, AutoCAD LT will display a message saying that the specified block
already exists and will ask if you want to redefine it. If you choose Yes, the block in the drawing
gets replaced by the drawing with the same name, that is, the block gets redefined.

Tip
You can create a block in a current drawing from an existing drawing file. This saves time by
avoiding redrawing the object as a block. Locate and select an existing file using the Browse
button and rename it with the name that you want to assign to the block in the Name edit box.
When you choose OK, you can insert the block in the drawing or press the ESC key. The new
block gets added to the current drawing.

Figure 14-7  The Insert dialog box
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Insertion point Area
When a block is inserted, the coordinate system of the block is aligned parallel to the current
UCS. In the Insertion point area, you can specify the X, Y, and Z coordinate locations of the
block insertion point in the X, Y, and Z edit boxes, respectively. If you select the Specify
On-screen check box, the X, Y, and Z edit boxes are not available and you can specify the
insertion point on the screen. By default, the Specify On-screen check box is selected and
hence, you can specify the insertion point on the screen.

Scale Area
In this area, you can specify the X, Y, and Z scale factors of the block to be inserted in the X, Y,
and Z edit boxes, respectively. By selecting the Specify On-screen check box, you can specify the
scale of the block at which it has to be inserted on the screen. The Specify On-screen check box
is cleared by default and the block is inserted with the scale factors of 1 along the three axes. Also,
if the Uniform Scale check box is selected, the X scale factor value is assumed for the Y and Z
scale factors also. This means that if this check box is selected, you need to specify only the X
scale factor. All the dimensions in the block are multiplied by the X, Y, and Z scale factors you
specify. These scale factors allow you to stretch or compress a block along the X and Y axes,
respectively, according to your needs. You can also insert 3D objects into a drawing by specifying
the third scale factor (since 3D objects have three dimensions), the Z scale factor. Figure 14-8
shows variations of the X and Y scale factors for the block, CIRCLE, during insertion.

Tip
By specifying negative scale factors, you can insert a mirror image of a block along the
particular axis. A negative scale factor for both the X and Y axes is the same as rotating the
block reference through 180-degree, since it mirrors the block reference in the opposite quadrant
of the coordinate system. In Figure 14-9, the effect of negative scale factor on block (DOOR)
can be marked by a change in position of insertion point marked with an (X).

Also, specifying a scale factor of less than 1 inserts the block reference smaller than the original
size and a scale factor greater than 1 inserts the block reference larger than its original size.

Rotation Area
You can enter the angle of rotation for the block to be inserted in the Angle edit box. The
insertion point is taken as the location about which the rotation takes place. Selecting the Specify
On-screen check box allows you to specify the angle of rotation on the screen. This check box
is cleared by default and the block is inserted at an angle of zero-degree.

Explode Check Box
By selecting this check box, the inserted block is inserted as a collection of individual objects.
The function of the Explode check box is identical to that of the EXPLODE command. Once
a block is exploded, the X, Y, and Z scale factors are identical. Hence, you are provided access
to only one scale factor edit box (X edit box), the Y and Z edit boxes are not available, and the
Uniform Scale check box also gets selected. The X scale factor is assigned to the Y and Z scale
factors too. You must enter a positive scale factor value.
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Note
If you select the Explode check box before insertion, the block reference is exploded and the
objects are inserted with their original properties such as layer, color, and linetype.

Once you have entered the relevant information in the dialog box, choose the OK button. The
Insert dialog box is removed from the screen and if you have selected the Specify On-Screen
check boxes, you can specify the insertion point, scale, and angle of rotation with a pointing
device. Whenever the insertion point is to be specified on screen (by default), you can specify
scale factors and rotation angle values that will override the values specified in the dialog box,
using the command line. Before you specify the insertion point on the screen, you can right-click
to display the shortcut menu, which has all the options available through the command line.

Figure 14-8  Block inserted with different scale factors

Figure 14-9  Block inserted using negative scale factors
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However, if you have already specified an insertion point in the dialog box and have selected the
Specify on-screen check boxes in the Scale or Rotation areas of the Insert dialog box, you are
allowed to specify only the scale factors or the rotation angle through the command line. You
can also use the command line where the following prompts appear.

Specify insertion point or [Basepoint/Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]:
Enter X scale factor, specify opposite corner, or [Corner/XYZ] <1>:
Enter Y scale factor <use X scale factor>:
Specify rotation angle <0>:

Tip
Using the command line allows you to override scale factors and rotation angles already
specified in the dialog box.

The command line options available are discussed next.

Scale X Y Z Rotate
PScale PX PY PZ PRotate

Basepoint
If you enter B at the Specify Insertion point prompt, or select the option from the selection
preview you are again prompted to specify the Base Point. Specify the Base Point by clicking
the cursor at the desired location. This point will now act as the insertion point. All prompts are
also  displayed at the cursor input so there is no need to always  take a look on the command
prompt. The prompt sequence for this option is given next.

Specify insertion point or
[Basepoint/Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]: B  �
Specify base point: Specify base point
Specify insertion point: Specify insertion point

Scale
If you enter S at the Specify Insertion point prompt, you are asked to enter the scale factor. After
entering the scale factor, the block assumes the specified scale factor, and AutoCAD LT lets you
drag the block until you locate the insertion point on the screen. The X, Y, and Z axes are
uniformly scaled by the specified scale factor. The prompt sequence for this option is given next.

Specify insertion point or [Basepoint/Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]: S
Specify scale factor for XYZ axes: Enter a value to preset general scale factor.
Specify insertion point: Select the insertion point.
Specify rotation angle <0>: Specify angle of rotation.

X, Y, Z
With X, Y, or Z as the response to the Specify insertion point prompt, you can specify the X, Y,
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or Z scale factors before specifying the insertion point. The prompt sequence when you use the
X option is given next.

Specify insertion point or [Basepoint/Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]: X
Specify X scale factor: Enter a value for the X scale factor.
Specify insertion point: Select the insertion point.
Specify rotation angle <0>: Specify angle of rotation.

Rotate
If you enter R at the Specify insertion point prompt, you are asked to specify the rotation angle.
You can enter the angle of rotation or specify the angle by specifying two points on the screen.
Dragging is resumed only when you specify the angle, and the block assumes the specified
rotation angle. The prompt sequence for this option is given next.

Specify insertion point or [Basepoint/Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]: R
Specify rotation angle: Enter a value for the rotation angle.
Specify insertion point: Select the insertion point.
Enter X scale factor, specify opposite corner, or [Corner/XYZ] <1>: Specify the X scale factor.
Enter Y scale factor <use X scale factor>: Specify the Y scale factor.

PScale
The PScale option is similar to the Scale option. The difference is that in the case of the PScale
option, the scale factor specified reflects only in the display of the block while it is dragged to
the desired position. This implies that you can preview the effect of this scale factor on the block
before actually applying it. After you have specified the insertion point for the block, you are
again prompted for a scale factor. If you do not enter the scale factor, the block is drawn exactly
as it was when created. The prompt sequence for this option is given next.

Specify insertion point or [Basepoint/Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]: PS
Specify preview scale factor for XYZ axes: Enter a value to preview the general scale factor.
Specify insertion point: Specify the insertion point for the block.
Enter X scale factor, specify opposite corner, or [Corner/XYZ] <1>: Specify the X scale factor.
Enter Y scale factor <use X scale factor>: Specify the Y scale factor.
Specify rotation angle <0>: Specify angle of rotation.

PX, PY, PZ
These options are similar to the PScale option. The only difference is that the X, Y, or Z scale
factors specified are reflected only in the display of the block while it is dragged to the desired
position. After you have specified the insertion point for the block, you are again prompted for
the X scale factor and the Y scale factor. If you do not enter the scale factor, the block is drawn
exactly as it was when created.

Specify insertion point or [Basepoint/Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]: PX
Specify preview X scale factor: Enter a value to preview the X scale factor.
Specify insertion point: Specify the insertion point for the block.
Enter X scale factor, specify opposite corner, or [Corner/XYZ] <1>: Specify the X scale factor.
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Enter Y scale factor <use X scale factor>: Specify the Y scale factor.
Specify rotation angle <0>: Specify angle of rotation.

Note
If you have already specified scale factors in the X, Y, and Z edit boxes of the Scale area of the
Insert dialog box, the PScale, PX, PY, and PZ options work equivalent to the Scale, X, Y, and
Z options respectively and allow you to insert the block with the PScale, PX, PY, or PZ values
you specified.

PRotate
The PRotate option is similar to the Rotate option. The difference is that the rotation angle
specified reflects only in the display of the block while it is dragged to the desired position.
After you have specified the insertion point for the block, you are again prompted for the angle
of rotation. If you do not enter the rotation angle, the block is drawn exactly as it was when
created (with the same angle of rotation as specified on the creation of the block). The prompt
sequence is given next.

Specify insertion point or [Basepoint/Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]: PR
Specify preview rotation angle: Specify the preview value for rotation.
Specify insertion point: Specify the insertion point for the block.
Enter X scale factor, specify opposite corner, or [Corner/XYZ]: Specify the X scale factor.
Enter Y scale factor < use X scale factor>: Specify the Y scale factor.
Specify rotation angle <0>: Specify angle of rotation.

Note
If you have already specified the rotation angle in the Angle edit box of the Rotation area of the
Insert dialog box, the PRotate option works equivalent to the Rotate option and allows you to
insert the block with the PRotate value you specified.

Tip
The preview options (PScale, PX, PY, PZ and PRotate) that are preceded with a P allow you
to view the effect of the scale factor or rotation angle specified before actually applying it to the
block reference.

The XYZ and Corner Options
When you are specifying the insertion point and scale factors on the screen, the following
prompt appears after you have selected an insertion point.

Enter X scale factor, specify opposite corner or [Corner/XYZ]: Enter X scale factor, specify
opposite corner or select an option.

Here, the XYZ option can be used to enter a 3D block reference and the successive prompts
allow you to specify the X, Y, and Z scale factors individually.
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With the Corner option, you can specify both X and Y scale factors at the same time. When you
invoke this option, and DRAGMODE is turned off, you are prompted to specify the other
corner (the first corner of the box is the insertion point). You can also enter a coordinate value
instead of moving the cursor. The length and breadth of the box are taken as the X and Y scale
factors for the block. For example, if the X and Y dimensions (length and width) of the box are
the same as that of the block, the block will be drawn without any change. The points selected
should be above and to the right of the insertion block. Mirror images will be produced if points
selected are below or to the left of the insertion point. The prompt sequence is given next.

Enter X scale factor, specify opposite corner or [Corner/XYZ]: C
Specify opposite corner: Select a point as the corner.

The Corner option also allows you to use a dynamic scaling technique when DRAGMODE is
turned to Auto (default). You can also move the cursor at the Enter X scale factor prompt to
change the block size dynamically and, when the size meets your requirements, select a point.

Note
You should try to avoid using the Corner option if you want to have identical X and Y scale
factors because it is difficult to select a point whose X distance equals its Y distance, unless the
SNAP mode is on. If you use the Corner option, it is better to specify the X and Y scale factors
explicitly or select the corner by entering coordinates.

INSERTING BLOCKS USING THE COMMAND LINE
Predefined blocks can also be inserted in a drawing with the -INSERT command, using the
command line. When using the -INSERT command, the dialog box is not displayed. To insert
a drawing file as a block, enter the file name at the Enter block name or [?] prompt. You can
enter ? if you do not know the name of the blocks in the drawing. To create a block with a
different name from the drawing file, enter blockname= file name at the Enter block name
or[?] prompt. If you enter (~) tilde character at the Enter block name or [?] prompt, the Select
Drawing File dialog box is displayed on the screen. If you enter an (*) asterisk before entering
the block name, the block is automatically exploded upon insertion. All the command line
options discussed earlier are available through the -INSERT command. Also, if you make changes
to a block and want to update the block in the existing drawing, enter blockname= at the
Specify insertion point prompt. AutoCAD LT will display the prompt:

Block “current” already exists. Redefine it? [Yes/No] <No>: Enter y to redefine it.

Note
If you create a template file that has blocks created and stored in it and use it to create a new
drawing, the blocks are available in the new drawing also.

Also when you insert a drawing into a current drawing, all the blocks belonging to the inserted
drawing are also brought into the current drawing.
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Using the dialog box, insert a block SQUARE into a drawing. The block insertion point is (1,2).
The X scale factor is 2 units, the Y scale factor is 2 units, and the angle of rotation is 35-degree.
It is assumed that the block SQUARE is already defined in the current drawing.

Choose the Insert Block button from the Draw toolbar. The Insert dialog box is displayed on
the screen. In the Name edit box, enter SQUARE or select the Block SQUARE from the Name
drop-down list. Clear the Specify On-screen check box. Now, in the Insertion point area, enter
1 in the X edit box and 2 in the Y edit box. In the Scale area, enter 2 in the X edit box and 2
in the Y edit box. In the Rotation area, enter 35 in the Angle edit box. Choose the OK button
to insert the block on the screen.

a. Insert the block CIRCLE created in Exercise 1. Use different X and Y scale factors to get
different shapes after inserting this block.

b. Insert the block CIRCLE created in Exercise 1. Use the Corner option to specify the scale
factor.

a. Construct a triangle and form a block of it. Name the block TRIANGLE. Now, set the Y
scale factor of the inserted block as 2.

b. Insert the block TRIANGLE with a rotation angle of 45-degree. After defining the insertion
point, enter an X and a Y scale factor of 2.

USING DESIGNCENTER TO INSERT BLOCKS
You can use the DESIGNCENTER to locate, preview, copy, or insert blocks or existing drawings
into a current drawing. On the Standard toolbar, choose the DesignCenter button to display
the DESIGNCENTER window (Figure 14-10). In this window, choose the Tree View Toggle
button to display the tree pane on the left side, if not already displayed. By default, the tree
pane is displayed. Expand My Computer to display the C:/Program Files/ACADLT 2006/Sample/
DesignCenter folder, by clicking on the plus (+) signs on the left of the respective folders. Click
on the plus sign adjacent to the folder to display its contents. Select a drawing file you wish to
use to insert blocks from and then click on the plus sign adjacent to the drawing again. All the
icons depicting the different types of content in the selected drawing are displayed, that is,
Blocks, Dimstyles, Layers, Linetypes, Textstyles, and so on. Select Blocks  by clicking on it and
a list of blocks in the drawing is displayed in the palette. Select the block you wish to insert, and
drag and drop it into the current drawing. Later, you can move it in the drawing to the
desired location. You can also right-click on the block name to display a shortcut menu.
Select Insert Block from the shortcut menu. The Insert dialog box is displayed. Here, you can
specify the Insertion point, scale, and rotation angle in the respective edit boxes. If you select
the Specify On-Screen  check boxes in the Insert dialog box, you are allowed to specify
these parameters on the screen. The selected block is inserted into the current drawing based on

Exercise 3 General

Exercise 2 General

Exercise 1 General
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the type of units specified when the block was created. For example, if you had created a block
of 1" X 1", and specified feet as units at that time, the block when inserted using the
DESIGNCENTER, will be 12" X 12". You can also choose Copy from the shortcut menu; the
selected block is copied to the clipboard. Now, you can right-click in the drawing area to display
a shortcut menu and choose Paste. The selected block is displayed attached to the cursor and as
you move the cursor, the block also moves with it. You can now select a point where you want to
paste the block. The advantage of this option over drag and drop is that you can select an
insertion point at the time of pasting. In the case of a drag and drop operation, you need to
move the inserted block to a specific point later and it is an additional step.

If you want to insert an entire drawing, select the folder in which the drawing resides by
double-clicking on the folder. All the contents in the folder are displayed in the palette. Drag
and drop the desired drawing into the current drawing. You can also select the drawing and
right-click to display a shortcut menu. Choose Insert as Block from the shortcut menu. The
Insert dialog box is displayed, where you can specify the Insertion point, scale factors, and
rotation angle, if required. You can also select the Specify On-screen check boxes to select
everything on the screen.

Note
For a detailed explanation of the DESIGNCENTER, see Chapter 6, Editing Sketched Objects-II.

Figure 14-10  Using the DESIGNCENTER to insert blocks
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USING TOOL PALETTES TO INSERT
BLOCKS
You can use the TOOL PALETTES window shown in Figure 14-11
to insert predefined blocks in the current drawing. The TOOL
PALETTES window has three tabs: Sample Office project,
Imperial Hatches, and ISO Hatches. In this chapter, you will
learn how to insert blocks using the Sample Office project tab of
the TOOL PALETTES.

Inserting Blocks in the Drawing
AutoCAD LT provides two methods to insert blocks from the
TOOL PALETTES: Drag and Drop method and Select and Place
method. Both these methods of inserting blocks using the
TOOL PALETTES are discussed next.

Drag and Drop Method
To insert blocks from the TOOL PALETTES in the drawing using
this method, move the cursor over the desired predefined block
in the TOOL PALETTES. You will notice that as you move the
cursor over the block, the block icon gets converted into a 3D
icon. Also, a tooltip is displayed that shows the name and
description of the block. Press and hold the left mouse button
and drag the cursor to the drawing area. Release the left mouse button, and you will notice that
the selected block is inserted in the drawing. You may need to modify the drawing display area
to view the block. Remember that when a block is inserted from the TOOL PALETTES using
the drag and drop method, you are not prompted to specify the rotation angle or the scale of the
block. The blocks are automatically inserted with their default scale factor and rotation angle.

Select and Place Method
You can also insert the desired block in the drawings using the select and place method. To
insert the block, move the cursor over the desired block in the TOOL PALETTES. The  block
icon is changed to a 3D icon. Press the left mouse button, the selected block is attached to the
cursor and the Specify insertion point or [Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]
prompt is displayed. Move the cursor to the required location in the drawing area and press the
left mouse button. The selected block is inserted at the specified location.

Modifying the Properties of the Blocks Available in the
TOOL PALETTES
To modify the properties of the blocks, move the cursor over the block in the TOOL
PALETTES and right-click on it to display the shortcut menu. Using the options in this shortcut
menu, you can cut or copy the desired block available in one tab of TOOL PALETTES and
paste it on the other tab. You can also delete and rename the selected block using the Delete

Figure 14-11  The  TOOL
PALETTES window
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Tool and Rename options, respectively. To modify the properties of the block, choose Properties
from the shortcut menu. The Tool Properties dialog box is displayed as, shown in Figure 14-12.

In the Tool Properties dialog box, the name of the selected block is displayed in the Name edit
box. You can rename the block by entering a new name in the Name edit box. The Image
area available on the left of the Name edit box displays the image of the selected block. If you
enter a description of the block in the Description text box, it is stored with the block
definition in the TOOL PALETTES. Now, when you move the cursor over the block in
TOOL PALETTES and pause for a second, the description of the block appears along with its
name in the tooltip. Note that when you select a particular field in the Tool Properties dialog
box, its function is displayed in the description box available at the bottom of the dialog box.
The Tool Properties dialog box displays the properties of the selected block under the
following categories.

Insert
In this category, you can specify the insertion properties of the selected block such as its name,
original location of the block file, scale, and rotation angle. The Name edit box specifies the
name of the block. The Source File edit box displays the location of the file in which the
selected block is created. When you choose the [...] button in the Source File edit box,
AutoCAD LTdisplays the location of the file in the Select Linked Drawing dialog box. The
Scale edit box is used to specify the scale factor of the block. The block will be inserted in the
drawing according to the scale factor specified in this edit box. You can enter the angle of
rotation for the block to be inserted in the Rotation edit box. The Explode edit box is used to
specify whether the block will be exploded while inserting or will be inserted as a single entity.

Figure 14-12  The Tool Properties dialog box
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General
In this category, you can specify the general properties of the block such as the Color, Layer,
Linetype, Plot style, and Lineweight for the selected block. The properties of a particular field
can be modified from the drop-down list available on selecting that field.

ADDING BLOCKS IN THE TOOL PALETTES
By default, the TOOL PALETTES window displays the predefined blocks available in AutoCAD.
You can also add the desired block and the drawing file to the TOOL PALETTES window. This
is done using the DESIGNCENTER. AutoCAD LT provides two methods for adding the blocks
from the DESIGNCENTER to the TOOL PALETTES: Drag and Drop method and Shortcut
menu. These two methods are discussed next.

Drag and Drop Method
To add the blocks from the DESIGNCENTER in the TOOL PALETTES, move the cursor over
the desired block in the DESIGNCENTER. Press and hold the left mouse button on the block
and drag the cursor to the TOOL PALETTES window. As you drag the cursor in the TOOL
PALETTES window, you will notice that a box with a + sign is attached to the cursor and a black
line appears on the TOOL PALETTES window, as shown in Figure 14-13. If you move the
cursor up and down in the TOOL PALETTES, the black line also moves between the two
consecutive blocks. This line is used to define the position of the block to be inserted in the
TOOL PALETTES window. Release the left mouse button and you will notice that the selected
block is added to the location specified by the black line in the TOOL PALETTES.

Shortcut Menu
You can also add the desired block from the DESIGNCENTER to the TOOL PALETTES
using the shortcut menu. To add the block, move the cursor over the desired block in the
DESIGNCENTER and right-click on it to display a shortcut menu. Choose Create Tool Palette
from the shortcut menu. You will notice that a new tab with the name New Tool Palette is added
to the TOOL PALETTES and the block is added in the new tab of the TOOL PALETTES.
Also, a text box appears that displays the current name of the tab. You can change the name of
the tab by entering a new name in this text box.

You can also add a number of blocks available in a drawing simultaneously to the
TOOL PALETTES using the following two methods.

Right-click on the Palette area of the DESIGNCENTER to display the shortcut menu. Choose
Create Tool Palette from the shortcut menu; a new tab is added to the TOOL PALETTES with
the same name as that of the drawing selected in the DESIGNCENTER. This new tab contains
all the blocks that were available in the drawing that you selected from the DESIGNCENTER.

You can also add the blocks available in the drawing simultaneously by right-clicking on the
drawing in the Tree View of the DESIGNCENTER. A shortcut menu is displayed. Choose
Create Tool Palette from the shortcut menu and you will notice that a new tab is added to the
TOOL PALETTES, which contains all the blocks that were available in the selected drawing.
You will also notice that the new tab has the same name as that of the selected drawing.
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MODIFYING EXISTING BLOCKS IN THE TOOL PALETTES
If you modify an existing block that was added to the TOOL PALETTES, and then insert it
using the TOOL PALETTES in the same or a new drawing, you will notice that the modified
block is inserted and not the original block. But note that if you insert the modified block from
the TOOL PALETTES in a drawing in which the original block was already inserted, AutoCAD LT
inserts the original block and not the modified block. This is because the file already has a block
of the same name in its memory.

To insert the modified block, you first need to delete the original block from the current drawing
using the ERASE command. Next, you need to delete the block from the memory of the current
drawing. The unused block can be deleted from the memory of the current drawing using the
PURGE command. To invoke this command, enter PURGE at the Command prompt. The
Purge dialog box is displayed. Choose the (+) sign located on the left of Blocks in the tree view
available in the Items not used in drawing area. You will notice that a list of blocks available in
the drawing is shown. Select the original block to be deleted from the memory of the current
drawing and then choose the Purge button. The Confirm Purge dialog box is displayed that
confirms the purging of the selected item. Choose Yes in this dialog box and then choose the
Close button to exit the Purge dialog box. Next, when you insert the block using the TOOL
PALETTES, the modified block is inserted in the drawing.

Figure 14-13  Specifying the location of the block
to be inserted in the TOOL PALETTES window
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Note
You will learn more about the PURGE command in Chapter18, Grouping and Advanced Editing
of Sketched Objects. Deleting unused blocks using the command line is, however, discussed later
in this chapter.

If you create a block with the name that is defined in the TOOL PALETTES, the block in the
TOOL PALETTES is redefined in the current drawing. However, when you open a new drawing
and insert the block using the TOOL PALETTES, the original block will be inserted.

DYNAMIC BLOCKS
The concept of the dynamic blocks has been introduced in this release of AutoCAD LT. You can
dynamicaly manipulate the dynamic blocks in the drawing. It
provides you the flexibility of modifying the geometry of the
inserted blocks dynamically using the grips or using the
PROPERTIES window. The blocks inserted using the TOOL
PALETTES are dynamic blocks. The necessity of dynamic ma-
nipulation arises due to design needs. For example, if you have
inserted Aluminium Window (elevation) block from the TOOL
PALETTES, you may be required to change the size of the
window in the drawing. With the facility of dynamic manipulation
of dynamic blocks, all you have to do is just select the block to
display the grips. Now select the grip and drag it to manipulate
the block dynamically. Grips of different shapes are available in
dynamic blocks. These grips may vary from block to block. There
is a specific purpose of each grip. The purpose of each grip is
discussed next. Figure 14-14 lists the different types of grips.

Standard Grip
The Standard grip is available with almost all dynamic blocks. This grip is used to  manipulate
the block in any direction, in the current plane. To manipulate a block dynamically using the
Standard grip,  select the grip using the left mouse button and drag it to specify the new
location. Figure 14-15 displays a block being manipulated dynamically using the Standard grip.

Linear Grip
The Linear grip is used to manipulate the block only in the linear direction. Figure 14-17
displays a dynamic block being manipulated using the Linear grip. Take a look at the location
of the cursor and the direction of manipulation. Since the block is  bound to be manipulated in
linear direction, irrespective of the angular movement of the cursor, it will be manipulated
linearly. The small gray lines shown in the Figure 14-16 are predefined steps. Predefined steps
are the scales, in which the block will be manipulated. You cannot size the block to any other
scale other than the steps provided.

Figure 14-14  Types of Grips
in dynamic blocks
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Rotation Grip
The Rotation grip is used to manipulate the block about a basepoint. To manipulate the block,
select the Rotation grip and move it; the block will also rotate accordingly, with respect to the
base point.

Flip Grip
The Flip grip is used to manipulate the block about a flip line. Figure 14-17 displays dynamic
manipulation of the block using the Flip grip. Click on the grip once to flip the entity. If you
click on the grip again then the entity will flip back to its original position.

Figure 14-16  Manipulation of the block using the Linear grip

Figure 14-15  Manupulation of the block using the Standard grip
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Alignment Grip
The Alignment grip is used to align the entire dynamic block with the other entities in the
drawing. The alignment is defined using the base point of the alignment, at which the dynamic
block grip is created. The block is rotated and moved while aligning.

Lookup Grip
The Lookup grip is used to view the different visibility states of a block.  Click on the Lookup
grip to display a shortcut menu. This shortcut menu contains all visibility states of the block.
Select the visibility state that you want should be displayed on screen. Take a look at Figure 14-18,
the different visibility states of Hex Socket Bolt are listed in the shortcut menu. In Figure 14-18(A)

Figure 14-17  Manipulation of the block using the Flip grip

Figure 14-18  Manipulation of the block using the Lookup grip
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the size of the bolt is M8, After selecting M14 from the shortcut menu, the size of the bolt that
is being displayed on the graphics window becomes M14.

LAYERS, COLORS, LINETYPES, AND LINEWEIGHTS FOR
BLOCKS
A block possesses the properties of the layer on which it is drawn. The block may be composed
of objects drawn on several different layers, with different colors, linetypes, and lineweights. All
this information is preserved in the block. At the time of insertion, each object in the block is
drawn on its original layer with the original linetype, lineweight, and color, irrespective of the
current drawing layer, object color, object linetype, and object lineweights. You may want all
instances of a block to have identical layers, linetype properties, lineweight, and color. This can
be achieved by allocating all the properties explicitly to the objects forming the block. On the
other hand, if you want the linetype and color of each instance of a block to be set according to
the linetype and color of the layer on which it is inserted, draw all the objects forming the block
on layer 0 and set the color, lineweight, and linetype to BYLAYER. Objects with a BYLAYER
color, linetype, and lineweight can have their colors, linetypes, and lineweights changed after
insertion by changing the layer settings. If you want the linetype, lineweight, and color of each
instance of a block to be set according to the current explicit linetype, lineweight, and color at
the time of insertion, set the color, lineweight, and linetype of its objects to BYBLOCK. You can
use the PROPERTIES, CHPROP, or CHANGE command to change some of the characteristics
associated with a block (such as layer).

Note
The block is inserted on the layer that is current, but the objects comprising the block are drawn
on the layers on which they were drawn when the block was being defined.

For example, assume block B1 includes a square and a triangle that were originally drawn on
layer X and layer Y, respectively. Let the color assigned to layer X be red and to layer Y be green.
Also, let the linetype assigned to layer X be continuous and for layer Y be hidden. Now, if we
insert B1 on layer L1 with color yellow and linetype dot, block B1 will be on layer L1, but the
square will be drawn on layer X with color red and linetype continuous, and the triangle will be
drawn on layer Y with color green and linetype hidden.

The BYLAYER option instructs AutoCAD LT to assign objects within the block the color and
linetype of the layers on which they were created. There are three exceptions:

1. If objects are drawn on a special layer (layer 0), they are inserted on the current layer. These
objects assume the characteristics of the current layer (the layer on which the block is inserted)
at the time of insertion, and can be modified after insertion by changing that layer’s settings.

2. Objects created with the special color BYBLOCK are generated with the color that is current
at the time of insertion of the block. This color may be explicit or BYLAYER. You are thus
allowed to construct blocks that assume the current object color.

3. Objects created with the special linetype BYBLOCK are generated with the linetype that is
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prevalent at the time the block is inserted. Blocks are thus constructed with the current
object linetype, which may be BYLAYER or explicit.

Note
If a block is created on a layer that is frozen at the time of insertion, it is not shown on the screen.

Tip
If you are providing drawing files to others for their use, using only the BYLAYER settings
provide the greatest compatibility with varying office standards for layer/color/
linetype/lineweight, because they can be changed more easily after insertion.

NESTING OF BLOCKS
The concept of having one block within another block is known as the nesting of blocks. For
example, you can insert several blocks by selecting them and then with the BLOCK command,
create another block. Similarly, if you use the INSERT command to insert a drawing that
contains several blocks into the current drawing, it creates a block containing nested blocks in
the current drawing. There is no limit to the degree of nesting. The only limitation in nesting of
blocks is that blocks that reference themselves cannot be inserted. The nested blocks must have
different block names. Nesting of blocks affects layers, colors, and linetypes. The general rule is
as follows.

If an inner block has objects on layer 0, or objects with linetype or color BYBLOCK, these
objects may be said to behave like fluids. They “float up” through the nested block structure
until they find an outer block with fixed color, layer, or linetype. These objects then assume the
characteristics of the fixed layer. If a fixed layer is not found in the outer blocks, then the objects
with color or linetype BYBLOCK are formed; that is, they assume the color white and the
linetype CONTINUOUS.

To make the concept of nested blocks clear, consider the following example.
1. Draw a rectangle on layer 0, and form a block of it named X.
2. Change the current layer to OBJ, and set its color to red and linetype to hidden.
3. Draw a circle on OBJ layer.
4. Insert the block X in the OBJ layer.
5. Combine the circle with the block X (rectangle) to form a block Y.
6. Now, insert block Y in any layer (say, layer CEN) with color green and linetype continuous.

You will notice that block Y is generated in color red and linetype hidden. Normally, block X,
which is nested in block Y and created on layer 0, should have been generated in the color
(green) and linetype (continuous) of the layer CEN. This is because the object (rectangle) on
layer 0 floated up through the nested block structure and assumed the color and linetype of the
first outer block (Y) with a fixed color (red), layer (OBJ), and linetype (hidden). If both the
blocks (X and Y) were on layer 0, the objects in block Y would assume the color and linetype of
the layer on which the block was inserted.

Example 2 General
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1. Change the color of layer 0 to red.
2. Draw a circle and form a block of it, B1, with color BYBLOCK. It appears white because the

color is set to BYBLOCK (Figure 14-19).
3. Set the color to BYLAYER and draw a square. The color of the rectangle is red.
4. Insert block B1. Notice that the block B1 (circle) assumes red color.
5. Create another block B2 consisting of Block B1 (circle) and rectangle.
6. Create a layer L1 with green color and hidden linetype. Insert block B2 in layer L1.
7. Explode block B2. Notice the change.
8. Explode block B1, circle. You will notice that the circle changes to white because it was

drawn with the color set to BYBLOCK.

Part A
1. Draw a unit square on layer 0 and make it a block named B1.
2. Make a circle with radius 0.5 and change it into block B2.
3. Insert block B1 into a drawing with an X scale factor of 3 and a Y scale factor of 4.
4. Now, insert the block B2 in the drawing and position it at the top of B1.
5. Make a block of the entire drawing and name it PLATE.
6. Insert the block Plate in the current layer.
7. Create a new layer with different colors and linetypes and insert blocks B1, B2, and Plate.

Keep in mind the layers on which the individual blocks and the inserted block were made.

Part B
Try nesting the blocks drawn on different layers and with different linetypes.

Figure 14-19  Blocks versus layers and colors

Exercise 4 General

Example 3 General
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Part C
Change the layers and colors of the different blocks you have drawn so far.

CREATING DRAWING FILES USING THE WRITE BLOCK
DIALOG BOX

The blocks or symbols created by the BLOCK command can be used only in the drawing in
which they were created. This is a shortcoming because you may need to use a particular block in
different drawings. The WBLOCK command is used to export symbols by writing them to new
drawing files that can then be inserted in any drawing. With the WBLOCK command, you can
create a drawing file (.dwg extension) of specified blocks, selected objects in the current drawing,
or the entire drawing. All the used named objects (linetypes, layers, styles, and system variables)
of the current drawing are inherited by the new drawing created with the WBLOCK command.
This block can then be inserted in any drawing.

When the WBLOCK command is invoked, the Write Block dialog box is displayed (Figure 14-20).
This dialog box converts blocks into drawing files and also saves objects as drawing files.  You
can also save the entire current drawing as a new drawing file.

The Write Block dialog box has two main areas: Source and Destination. The Source area
allows you to select objects and blocks, specify insertion base points and convert them into
drawing files. In this area of the dialog box, depending on the selection you make, different

Command: WBLOCK

Figure 14-20  The Write Block dialog box
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default settings are displayed. By default, the Objects radio button is shown as selected and in
the Destination area, the File name and path edit box displays new block.dwg as the new file
name and its location. The Block drop-down list is also not available. Now, you can select
objects in a drawing and save them as a wblock, and can enter a name and a path for the file. If
the current drawing consists of blocks and if you want to save a block as a wblock, you can select
the Block radio button which is available. When the Block radio button is selected, the Block
drop-down list is available. The Block drop-down list displays all the block names in the current
drawing and you can select a name of the block that you want to convert into a wblock. The Base
point and Objects areas are not available, since the insertion points and objects have already
been saved with the block definition. Also, you will notice that in the Destination area, the File
name and path edit box displays the name of the selected block by default. This means that you
can keep the name of the wblock the same as the selected block or you can change the name if
you want to. Selecting the Entire drawing radio button selects the current drawing as a block
and saves it as a new file. When you use this option, the Base point and Objects areas are not
available.

The Base point area allows you to specify the base point of a wblock, which it uses as an insertion
point. You can either enter values in the X, Y, and Z edit boxes or choose the Pick point button
to select it on the screen. The default value is 0,0,0. The Objects area allows you to select objects
to save as a file. You can use the Select objects button to select objects or use the QuickSelect
button to set parameters in the Quick Select dialog box to select objects in the current drawing.
The number of objects selected is displayed at the bottom of the Objects area. If the Retain
radio button is selected in the Objects area, the selected objects in the current drawing are kept
as such after they have been saved as a new file. If the Convert to block radio button is selected,
the selected objects in the current drawing are converted into a block with the same name as the
new file after being saved as a new file. Selecting the Delete radio button deletes the selected
objects from the current drawing after they have been saved as a file.

Note
Both the Base point and Objects areas are available in the Write Block dialog box only when
the Objects radio button is selected in the Source area of the dialog box.

The Destination area sets the File name, location, and units of the new file in which the selected
objects are saved. In the File name and path edit box you can specify the file name and the path
of the block or the selected objects. You can choose the [...] button to display the Browse for
folder window, where you can specify a path for where the new file will be saved. From the Insert
Units drop-down list, you can select the units the new file will use when inserted as a block. The
settings for units are stored in the INSUNITS system variable and the default option Inches has
a value of 1. On specifying the required information in the dialog box, choose OK. The objects
or the block is  saved as a new file in the path specified by you. A WBLOCK Preview window
with the new file contents is displayed. This preview image is stored and displayed in the
DESIGNCENTER, when using it to insert drawings and blocks.

Note
Whenever a drawing is inserted into a current drawing, it acts as a single object. It cannot be
edited unless exploded.
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Tip
Using the Entire drawing radio button in the Write Block dialog box to save the current
drawing as a new drawing is a good way to reduce the drawing file size, since all unused
blocks, layers, linetypes, text styles, dimension styles, multiline styles, shapes, and so on are
removed from the drawing. The new drawing does not contain any information that is no
longer needed. This Entire drawing option is faster than the -PURGE command (which also
removes unused named objects from a drawing file) and can be used whenever you have
completed a drawing and want to save it. The -PURGE command has been discussed later in
this chapter.

CREATING DRAWING FILES USING THE COMMAND LINE
The -WBLOCK command can be used to create drawing files when you want to use the command
line. When this command is invoked, AutoCAD LT displays the Create Drawing File dialog
box, except when the system variable FILEDIA is set to 0. This dialog box displays a list of all
the drawing files in the current directory. Enter the name of the output drawing file in the File
name edit box and then choose the Save button. If the file name you specify is identical to some
other file in the same directory path, AutoCAD LT displays a message saying that a file with the
same name already exists and asks if you want to replace it. After choosing the Save button, the
dialog box is cleared from the screen, and AutoCAD LT issues the following prompt asking you
for the name of an existing block that you want to convert into a permanent symbol.

Enter name of existing block or
[= (block=output file)/* (whole drawing)] <define new drawing>: Enter the name of a predefined
block.

The drawing file with the name specified in the dialog box is created from the predefined block.

If you want to assign the same name to the output drawing file as that of the existing block, enter
an (=) equal sign as a response to the Enter name of existing block prompt and enter the same
file name in the File name edit box of the Create Drawing File dialog box. If a block by the
name you have already assigned to the output file does not exist in the current drawing,
AutoCAD LT gives an appropriate message that no block by that name exists in the current
drawing, and the Enter name of existing block or prompt is repeated. This option is the same
as the Block option of the WBLOCK command.

If you have not yet created a block, but want to create an output drawing file of the objects in the
current drawing, press ENTER at the Enter name of existing block prompt. You are then
required to select an insertion point and select the objects to be incorporated in the drawing file.
This option is the same as the Objects option of the WBLOCK command.

You can also store an entire drawing as a wblock. In other words, the current file is copied into
a new one specified in the File name edit box. To do so, respond to the prompt Enter name of
existing block with an asterisk (*). The entire drawing is saved in the file in the directory you
have specified. This option is the same as the Entire drawing option of the  WBLOCK command.
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Export Data Dialog Box
You can also use the Export Data dialog box (Figure 14-21) to create drawing files. This dialog
box can be invoked by choosing File > Export from the menu bar or by entering EXPORT at
the Command prompt. In this dialog box, you can select Block (*.dwg) from the Save as type
drop-down list, enter the name of the drawing file in the File name edit box, and then choose
the Save button. The dialog box is cleared from the screen and AutoCAD LT issues the same
prompts as the -WBLOCK command discussed earlier.

DEFINING THE INSERTION BASE POINT

The BASE command lets you set the insertion base point for a drawing just as you set the base
insertion point using the BLOCK command. This base point is defined so that when you insert
the drawing into some other drawing, the specified base point is placed on the insertion point.
By default, the base point is at the origin (0,0,0). When a drawing is inserted on a current layer,
it does not inherit the color, linetype, or thickness properties of the current layer. When you
invoke the BASE command, the prompt sequence is given next.

Enter base point <0.0000,0.0000,0.0000>: Specify a base point or press ENTER to accept the
default.

Menu: Draw > Block > Base
Command: BASE

Figure 14-21  The  Export Data dialog box
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Tip
You can insert a drawing that you want to refer to for checking dimensions or certain features
into the current drawing for reference. Then later you can use the UNDO command to delete
the inserted drawing. This way you can save stationery and time spent in printing.

Note
Drawings inserted into a current drawing become part of the current drawing and increase the
file size. Also, when the drawing is modified it does not get updated in the drawing; it has been
inserted automatically. Hence, it is better to xref a drawing into the current drawing instead.
External references is discussed in Chapter 16, Understanding External References.

a. Create a drawing file named CHAIR using the WBLOCK command. Get a listing of your
.dwg files and make sure that  CHAIR.dwg is listed. Quit the drawing editor.

b. Begin a new drawing and insert the drawing file into the drawing. Save the drawing.

Breaking Up a Block
A block may be composed of different basic objects such as lines, arcs, polylines, and circles. All
these objects are grouped together in the block and are treated as a single object. To edit any
particular object of a block, the block needs to be “exploded,” or split into independent parts.
This is especially useful when an entire view or drawing has been inserted and a small detail
needs to be corrected. This can be done in the following ways.

Selecting the Explode Check Box in the Insert Dialog Box
As discussed earlier, individual objects within a block cannot be edited unless the block is
broken up (exploded). You can explode a block at the time of insertion by simply selecting the
Explode check box before you choose OK in the Insert dialog box. Now, when the block is
inserted, it would have been already exploded into its component objects.

Entering * as the Prefix of Block Name
To insert a block as a collection of individual objects (exploded), you can also enter an
asterisk before its name, when using the command line. The prompt sequence for exploding the
block BLOCKPLAN while inserting is given next.

Command: -INSERT
Enter block name or [?] <current>: *BLOCKPLAN
Specify insertion point or [Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]: Select the insertion
point.
Scale factor <1>: �
Specify rotation angle <0>: �

The inserted object will no longer be treated as a block. The figure consists of various objects
that can be edited separately.

Exercise 5 General
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Note
Blocks with different X, Y, and Z values or nonuniformly scaled blocks can also be exploded. This
was not possible in releases prior to the Release 13 of AutoCAD LT.

Using the EXPLODE Command

As mentioned earlier, the other method to
break a block into individual objects is by
using the EXPLODE command
(Figure 14-22). When you invoke the
EXPLODE command you are prompted to
select the block you want to explode.

Once you have selected the block you want to
explode, press ENTER. The EXPLODE
command explodes a block into its component objects regardless of the scale factors. It also
does not have control over the properties such as layer, linetype, lineweight, and  color of the
component objects. When a block is exploded, there may be no visible change in the drawing.
The drawing is identical except that the color and linetype may have changed because of floating
layers, colors, or linetypes. The exploded block is now a group of objects that can be edited
individually. To check whether the breaking of the block has taken place, select any object that
was formerly a part of the block; only that particular object should be highlighted. After a block
is exploded, the block definition continues to be in the block symbol table. After exploding a
block you can modify it and then redefine it by using the BLOCK command. The Block Definition
dialog box is displayed where you can select the name of the block you wish to redefine from the
Name drop-down list. Then, use the dialog box options and redefine it. You can also use the
-BLOCK command to redefine a block. Once you redefine a block, it automatically gets updated
in the current drawing and for future use.

Note
Blocks inserted with External references cannot be exploded.

When redefining a block if you do not explode the block into its components prior to redefining,
a warning message saying that the particular block references themselves are displayed by
AutoCAD LT.

Using the XPLODE Command

With the XPLODE command, you can explode a block or blocks into component objects and
simultaneously control their properties such as layer, linetype, color, and lineweight. The scale
factor of the object to be exploded should be equal. Note that if the scale factor of the objects to

Figure 14-22  Using the EXPLODE command

Toolbar: Modify > Explode
Menu: Modify > Explode
Command: EXPLODE

Command: XPLODE
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be exploded is not equal, you need to change the value of the EXPLMODE system variable to 1.
The command prompts are as follows.

Command: XPLODE
Select objects to XPlode
Select objects: Use any object selection method and select objects and then press ENTER.

On pressing ENTER, AutoCAD LT reports the total number of objects selected and also the
number of objects that cannot be exploded. If you select multiple object to be exploded,
AutoCAD LT further prompts you to specify whether the changes in the properties of the
component objects should be made individually or globally. The prompt is given next.

XPlode Individually/<Globally>: Enter i, g, or press ENTER to accept the default option.

If you enter i at the above prompt, AutoCAD LT will modify each object individually, one at a
time. The next prompt is given next.

Enter an option [All/Color/LAyer/LType/LWeight/Inherit from parent block/Explode]
<Explode>: Select an option.

All the options available are discussed next.

All. This option sets all the properties such as color, layer, linetype, and lineweight of the
selected objects after exploding them. AutoCAD LT prompts you to enter new color, linetype,
lineweight, and layer name for the exploded component objects.

Color. This option sets the color of the exploded objects. The prompt is given next.

New color [Truecolor/COlorbook]<BYLAYER>: Enter a color option or press ENTER.

When you enter BYLAYER, the component objects take on the color of the exploded object’s
layer and when you enter BYBLOCK, they take on the color of the exploded object.

Layer. This option sets the layer of the exploded objects. The default option is inheriting the
current layer. The command prompt is as follows.

Enter new layer name for exploded objects <current>: Enter an existing layer name or press
ENTER.

LType. This option sets the linetype of the components of the exploded object. The command
prompt is given next.

Enter new linetype name for exploded objects <BYLAYER>: Enter a linetype name or press
ENTER to accept the default.



14-36                                                                                            AutoCAD LT 2006 for Designers

LWeight. This option sets the lineweight of the components of the exploded object. The command
prompt is given next.

Enter new lineweight <BYLAYER>: Enter a lineweight or press ENTER to accept the default.

Inherit from parent block. This option sets the properties of the component objects to that of
the exploded parent object, provided the component objects are drawn on layer 0 and the color,
lineweight, and linetype are BYBLOCK.

Explode. This option explodes the selected object exactly as in the EXPLODE command.

Selecting the Globally option, applies changes to all the selected objects at the same time and
the options are similar to the ones discussed in the Individually option.

Tip
Using the XPLODE command is better than the EXPLODE command since it gives you an
added advantage of determining the properties of the exploded components of the block.

RENAMING BLOCKS

Blocks can be renamed with the RENAME command. AutoCAD LT displays the Rename
dialog box, see Figure 14-23. This dialog box allows you to modify the name of an existing
block. In the Rename dialog box, the Named Objects list box displays the categories of object
types that can be renamed, such as blocks, layers, dimension styles, linetypes, and text styles,
UCSs, views, and viewports. You can rename all of these except layer 0 and continuous linetype.
When you select Blocks from the Named Objects list, the Items list box displays all the block

Menu: Format > Rename
Command: RENAME

Figure 14-23  The Rename dialog box
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names in the current drawing. When you select a block name you want to rename from the Items
list box, it is displayed in the Old Name edit box. Enter the new name to be assigned to the
block in the Rename To edit box. Choosing the Rename To button applies the change in name
to the old name. Choose OK to exit the dialog box. For example, if you want to rename a block
named Drawing1 to Drawing2, select Drawing1 from the Items list box. It is displayed in the
Old Name edit box. Enter Drawing2 in the Rename To edit box and choose the Rename To
button. Drawing2 appears in the Items list box. Now, choose OK to exit the dialog box.

Note
The layer 0 and Continuous linetype cannot be renamed and therefore do not appear in the Items
list box, when Layers and Linetypes are selected in the named Objects list box.

You can also rename a block using the command line, if you enter -RENAME at the Command prompt.

DELETING UNUSED BLOCKS
Sometimes after completing a drawing, you may notice that the drawing contains several named
objects, such as dimstyles, textstyles, layers, blocks, and so on that are not being used. Since
these unused named objects unnecessarily occupy disk space, you may want to remove them.
Unused blocks can be deleted with the -PURGE command. For example, if you want to delete
an unused block named Drawing2, the prompt sequence is given next.

Command: -PURGE
Enter type of unused objects to purge
[Blocks/Dimstyles/LAyers/LTypes/Plotstyles/SHapes/textSTyles/Mlinestyles/Tablestyles/
Regapps/All]: B
Enter names to purge <*>: Drawing2
Verify each name to be purged? [Yes/No] <Y>: �
Purge block “Drawing2”? <N>: Y

If there are no objects to remove, AutoCAD LT displays a message that there are no unreferenced
objects to be purged.

Note
The unused blocks can also be deleted using the PURGE command discussed in Chapter 18
(Object Grouping and Editing Commands)

Preceding the name of the wblock with an (*) asterisk when entering the name of the wblock
while using the -WBLOCK command, or selecting the Entire drawing radio button in the
Write Drawing dialog box when creating a wblock using the WBLOCK command has the same
effect as using the -PURGE command. But, the WBLOCK command is faster and deletes the
unused named objects automatically, while the -PURGE command allows you to select the type of
named objects you want to delete, and it also gives you an option to verify the objects before
deletion occurs.
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Answer the following questions, and then compare your answers to those given at the end of
this chapter.

1. Individual objects in a block can be erased. (T/F)

2. A block can be mirrored by providing a scale factor of -1 for X. (T/F)

3. Blocks created by the BLOCK command can be used in any drawing. (T/F)

4. An existing block cannot be redefined. (T/F)

5. The _____________ command lets you create a drawing file (.dwg extension) of a block
defined in the current drawing. (T/F)

6. The _____________  command can be used to change the name of a drawing file. (T/F)

7. The __________ command is used to place a previously created block in a drawing.

8. You can delete unreferenced blocks with the __________ command.

9. You can use the __________ to locate, preview, copy, and insert blocks or existing drawings
into the current drawing.

10. The __________ window is displayed by pressing CTRL+3 and can be used to insert the
predefined blocks in the current drawing.

Answer the following questions.

1. An entire drawing can be converted into a block. (T/F)

2. The objects in a block possess the properties of the layer on which they are drawn, such as
color and linetype. (T/F)

3. If the objects forming a block were drawn on layer 0 with color and linetype BYLAYER, then
at the time of the insertion, each object that makes up a block is drawn on the current layer
with the current linetype and color. (T/F)

4. Objects created with the special color BYBLOCK are generated with the color that is current
at the time the block was inserted. (T/F)

Self-Evaluation Test

Review Questions
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5. Blocks inserted using the TOOL PALETTES can be manipulated dynamically. (T/F)

6. The block name is controlled by which system variable?

(a) EXTNAMES (b) EXTMIN
(c) EXTMAX (d) SAVENAME

7. Which command should you use if you want to get back the objects that consist of the block
and have been removed from the drawing?

(a) OOPS (b) BLIPS
(c) BLOCK (d) UNDO

8. By what amount is a block rotated if the values of both the X and Y scale factors is -1?

(a) 90 (b) 180
(c) 270 (d) 360

9. When you insert a drawing into a current drawing, how many of the blocks belonging to the
inserted drawing are brought into the current drawing?

(a) One (b) None
(c) All (d) Two

10. What command is used to create a rectangular array of a block?

(a) ARRAY (b) INSERT
(c) MINSERT (d) 3DARRAY

11. The WBLOCK-asterisk method or the Entire drawing option of the WBLOCK command
have the same effect as the PURGE command. The only difference is that with the PURGE
command, __________________________________________________________________.

12. Using the __________ command has the added advantage of being able to control the
properties of the exploded components of the block, besides being able to break up the
block into its component objects.

13. The Automatic Save feature is __________ during in-place reference editing.

14. The blocks created inside a square of one unit are called __________.

15. The Layer 0 and the Continuous linetype __________ be renamed using the RENAME
command.
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Exercises

Exercise 6 General

Figure 14-24  Drawing for Exercise 7

Exercise 7 Mechanical

Figure 14-25  Drawing for Exercise 8

Draw part (a) of Figure 14-24 and define it as a block named A. Then, using the block insert
command, insert the block in the plate as shown.

Draw the diagrams in Figure 14-25 using blocks.
a. Create a block for the valve, Figure 14-25(a).
b. Use a thick polyline for the flow lines.
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Exercise 8 Piping

Figure 14-26  Drawing for Exercise 9

Draw part (a) of Figure 14-26 and define it as a block named B. Then, using the relevant
insertion method, generate the pattern as shown. Note that the pattern is rotated at 30-degree.

Draw part (a) of Figure 14-27 and define it as a block named Chair. The dimensions of the chair
can be referred from the Problem Solving Exercise 3 of Chapter 5. Then, using the block insert
command, insert the chair around the table as shown.

Exercise 9 General

Figure 14-27  Drawing for Exercise 10



Answers to Self-Evaluation Test
1 - F, 2 - T, 3 - F, 4 - F, 5 - WBLOCK, 6 - RENAME, 7 - INSERT, 8 - PURGE,
9 - DESIGNCENTER, 10 - TOOL PALETTES
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Part II

Author’s Web sites
For Faculty: Please contact the author at stickoo@calumet.purdue.edu or tickoo@cadcim.com
to access the Web site that contains the following:

1. PowerPoint presentations, programs, and drawings used in this textbook.
2. Syllabus, chapter objectives and hints, and questions with answers for every chapter.

For Students: You can download drawing-exercises, tutorials, programs, and special topics by
accessing author’s Web site at www.cadcim.com or http://technology.calumet.purdue.edu/met/
tickoo/students/students.htm.
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